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9.1. Relevancia de la aplicación 
La evapotranspiración (ET) es el término usado para describir la cantidad de agua, expresada en 
mm/d, efectivamente perdida desde la superficie terrestre por evaporación y transpirada por las 
plantas. Luego de la precipitación, la ET es el mayor componente del ciclo del agua terrestre, 
devolviendo a la atmósfera más del 60% del agua recibida por precipitación (Mu et al. 2011). Debido 
a su importancia en el ciclo hidrológico se hace necesaria su precisa cuantificación para su uso tanto 
en la planificación y manejo de los recursos hídricos como en la producción agrícola. Técnicas 
convencionales tales como Bowen ratio, eddy covariance o lisímetros, han sido ampliamente usadas 
para estimar la ET sobre áreas homogéneas a escala de campo (e.g. Gowda et al. 2007). A pesar 
de su precisión, estos sistemas solo proveen información a escala local y son difíciles de extrapolar 
sobre áreas heterogéneas. A escalas regional y aún nacional, muchos países han adoptado el 
método propuesto por la FAO (Allen et al. 1998), basado en la ecuación de Penman-Monteith. Sin 
embargo esta metodología requiere la recopilación de una gran cantidad de información 
meteorológica y parámetros del tipo de la vegetación, muchas veces difíciles de obtener en forma 
representativa. En este sentido, actualmente los sensores remotos son reconocidos como una 
herramienta valiosa capaz de proveer estimaciones espacialmente explícitas de ET, tanto a escala 
local como regional (e.g. Di Bella et al. 2000, Coureault et al. 2003, Gowda et al. 2007, Mu et al. 
2011).  
 
 
9.2. Objective of the application 
El objetivo de este trabajo fue desarrollar rutina automática para la generación de un producto de ET 
utilizando información espectral derivada de los sensores MODIS e información meteorológica. 
Aplicando el método simplificado (Carlson et al. 1995, Jackson et al. 1997), se estimó la ET para la 
región central de la Argentina con una resolución espacial de 1km2 y temporal de 8 días. 
 
 
9.3. Información utilizada 
9.3.1. Datos locales - Regionales (in-situ) 
Los datos iniciales usados para derivar la evapotranspiración (ET) son (Tabla 9.1): 

 Temperatura de superficie (LST) derivado del producto MODIS Land Surface Temperature 
and Emissivity (MOD11A2): mod11a2.2009145.LST_Day_1km.tif; 

 Reflectancia espectral de superficie derivado del producto MODIS Surface Reflectances 
(Bandas 1 y 2 MOD09A1): mod09a1.2009145.sur_refl_b01.tif (b01: banda 1 - rojo y b02: 
banda 2 - infrarrojo cercano); 

 Temperatura del aire derivado de estaciones meteorológicas pertenecientes al Servicio 
Meteorológico Nacional (SMN) e INTA: airtemp.2009145.tif; 

 Modelo digital de elevaciones derivado de Shuttle Radar Topography Mission (SRTM); 

 Radiación neta: netrad.2009145.tif (producido por INTA siguiendo la aproximación 
propuesta por Kumar et al. (1997)). 
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Tabla 9.1. Características de las bases de datos 
 

Producto 
Resolución 

temporal 
Resolución 

especial 
Unidades 

Factor de 
escala 

Fuente 

Temperatura 
de superficie 

8 días 1 km Kelvin 0.02 MODIS
1
 

Reflectancia 
de superficie 
(bandas 1 y 

2) 

8 días 500 m Reflectancia 0.0001 MODIS
1
 

Temperatura 
del aire 

8 días 500 m Celsius - INTA 

Radiación 
neta 

8 días 500 m MJ m-2 d-1 - INTA 

(
1
 Warehouse Inventory Search Tool available at https://wist.echo.nasa.gov/api/ and 2 produced at INTA) 

 
 

9.3.2. Información derivada de GEONETCast – DevCoCast 
Aunque la metodología propuesta no utiliza información diseminada por GENETCast, INTA planea 
usar algunos de sus productos en futuras versiones del producto. Cabe destacar que una limitante al 
uso de los productos diseminados por GENETCast, es la cobertura parcial de área de interés. 
 
9.4. Metodología y descripción del area de estudio 
9.4.1. Methodology 
Para estimar la ET a escala regional se utilizará el método original propuesto por Jackson et al. 
(1977), conocido como "Método Simplificado", el cual calcula la ET diaria (ETd en mmd-1) 
relacionando la radiación neta recibida por la superficie y su diferencia de temperatura con el aire 
subyacente según: 
 
ETd=NRd-B(Ts-Ta)n (Eq. 2) 
 
donde NRd (mmd-1) es la radiación neta diaria, Ts (K) es la tempertura de superficie, Ta (K) es la 
temperatura del aire (cerca de la superficie), B (mmd-1K-1) y n son parámetros que dependen del 
tipo y el estado de la vegetación. Aunque es un método relativamente simple, ha sido usado en la 
estimación de la ET de cultivos agrícolas, forestaciones bosques nativos y pastizales, con muy 
buenos resultados (Seguin y Itier 1983, Lagouarde y Brunet 1991, Courault et al., 1994, Caselles et 
al., 1998, Nosetto et al., 2005). El producto de ET sera generado con una resolución especial de 
1km y temporal de 8 días. La metodología completa es presentada en la Figura 9.1. La radiación 
neta, la cual puede ser separada en radiación neta de onda corta (Sn) y radiación neta de onda 
larga (Ln), es calculada usando la estimaciones de la radiación solar teórica recibida (St) y el albedo 
de superficie (α). La radiación neta de onda corta (Sn) es obtenida en forma semi-empírica como:  
 
Sn = St (1-α) (Eq. 3) 
 
donde St es la radiación teórica incidente de onda corta y α es el albedo de superficie. 
 

 
Figura 9.1. Diagrama de flujos de la cadena de procesamiento del producto propuesto. 
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Siguiendo a Kumar et al. (1997), St es calculada como la radiación solar potencial recivida bajo 
condiciones de cielo despejado en respuesta a la latitud y la elevación, usando un modelo digital de 
elevaciones e infomación de a latitud, para estudiar la variación en la radiación para diferentes 
orientaciones y pendientes del terreno. El albedo de superficie (α) es estimado usando los valores de 
reflectancia a partir de las bandas 1 (620-670 nm), 2 (841-876 nm), 3 (459-479 nm), 4 (545-565 nm), 5 
(1230-1250 nm) and 7 (2105-2155 nm) del instrument MODIS-TERRA, basado en la aproximación 
propuesta por Liang (2000): 
 
α = 0.160α1+0.291α2+0.243α3+0.116α4+0.112α5+0.081α7-0.0015 (Eq. 4) 
 
donde α (1 to 7) son los valores de reflectancia a partir de las respectivas bandas de MODIS-TERRA. La 
radiación neta de onda larga (Ln) es estimada empíricamente de acuerdo a Granger y Gray (1990). 
Asumiendo que las variaciones en la humedad atmosférica son controladas por la energía disponible en la 
superficie terrestre (NR), para condiciones de cielo despejado y a escala diaria, Ln puede ser estimado a 
partir de la radiación de onda corta incidente (St) como: 
 
Ln = -4.25-0.24St (Eq. 5) 
 
Debido a la falta de validación de esta estimación se planea usar en futuras versiones del producto, 
información diseminada vía GEONETCast, tal como Downward Surface Short-wave Flux and Downward 
Surface Long-wave Flux, para estimar la radiación neta siguiendo la metodología propuesta por LSA-SAF 
en su producto de ET (http://landsaf.meteo.pt). Entonces, ambos aproximaciones serán comparados y se 
decidirá utilizar el método que mejor se ajuste a datos de radiación neta tomados a campo. 
La temperature de superficie (Ts) es obtenida de del producto de MODIS Land Surface Temperature and 
Emissivity, mientras que la temperatura del aire cerca de la superficie (Ta) es derivada de las estaciones 
meteorológicas presentes en el área de estudio. 
El parámetro B representa la conductancia promedio diaria del flujo de calor sensible y n es un factor de 
corrección para condiciones no neutrales de estabilidad atmosférica (Kalma et al., 2008). Mientras B 
depende de la rugosidad de la superficie, n depende de la estabilidad de la atmósfera y ambos 
coeficientes están estrechamente relacionados con la cantidad de vegetación o la fracción de suelo 
cubierto por la vegetación, la cual puede ser estimada a partir del índice de vegetación escalado, 
conocido como Scaled Normalized Vegetation Index or NDVI* (Carlson et al., 1995), donde: 
 
NDVI* = (NDVI-NDVImin)/(NDVImax-NDVImin) (Eq. 6) 
 
El Índice de Vegración de diferencia Normalizada (NDVI) también puede ser obtenido del producto NDVI 
de MODIS. Finalmente, B y n serán calculados siguiendo las ecuaciones propuestas por Carlson et al. 
(1995), donde: 
 
B = 0.0109+0.051(NDVI*) (Eq. 7) 
n = 1.067-0.372(NDVI*) (Eq. 8) 
 
 
9.4.2. Study Area 
El area de interés (Figura 9.2) incluye la porción central del territorio argentino. Esta área abarca los 
territorio de 9 provincias, incluyebdo: Buenos Aires, Entre Ríos, Santa Fe, Córdoba, La Pampa, San Luis, 
San Juan, La Rioja, Rio Negro and Neuquén. De este a oeste, esta región presenta amplios gradientes 
climáticos, de tipos de suelo y usos de la tierra. 
 

 
Figura 9.2. Área de estudio. Los triángulos muestran la ubicación de las estaciones meteorológicas 

utilizadas para estimar la ET. 

http://landsaf.meteo.pt/
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9.5. Pre-procesamiento de la información 
9.5.1. Información derivada de sensors remotos 

Como se mencionó más arriba, en la ecuación 2 la temperatura de superficie (Ts), el NDVI (necesario 
para calcular los coeficientes B y n) y los valores de reflectancia espectral de superficie (necesario para 
calcular el albedo en la estimación de la radiación neta) son obtenidos de los productos MODIS-TERRA. 
Específicamente, se hace uso de los productos Surface Spectral Reflectance 8-day L3 Global 500m 
(MOD9A1) y Land Surface Temperature/Emissivity 8-day L3 Global 1km (MOD11A2). Para cubrir el área 
de interés en su totalidad fueron utilizados dos escenas MODIS: h12v12 y h12v13.  
La temperatura de superficie necesita ser remuestreada para obtener un tamaño de píxel de 500m, en 
coincidencia con la resolución espacial del producto MOD09A1.  
Antes de arribar al cálculo de ET es necesario importar y pre-procesar las imágenes utilizadas.  
Copie y descomprima en su disco local c:\ el ejercicio (chapter9.zip). En su disco local c:\ usted ahora 
debe tener una carpeta llamada “chapter9” conteniendo los siguientes subdirectorios: „DataInput‟ y 
„Working_Dir‟. La carpeta DataInput contiene los siguientes sub-directorios: „1_SufraceTemp‟, 
„2_SurfaceReflect‟, „3_AirTemp‟ and „4_NetRad‟. Abra el ILWIS y use el navegador para dirigirse al 
directorio “C:\Chapter9\Working_Dir”. 
 
 
9.5.1.1. Importar y re-escalar el producto LST de MODIS 
Para importer todas las imágenes necesarias de LST MODIS (mod11a2*.tif) con el propósito de estimar 
ET para un período de tiempo usando el menú contextual de ILWIS puede ser algo incómodo. Use el 
explorador de Windows para conocer el contenido del subdirectorio: 
”C:\chapter9\DataInput\1_SurfaceTemp”. Allí se encuentran 4 archivos. El archive “SurfaceTemp.rar” 
contiene las imágenes originales de temperatura de superficie (LST) en formato TIFF para 4 fechas 
consecutivas. Con el propósito de importar esas imágenes en forma automática, en el mismo directorio se 
encuentran dos archivos *.bat “multi_import_SurfaceTemp_start.bat” and “multi_import_SurfaceTemp.bat”. 
El contenido de esos archivos puede verse en las figuras 9.3 y 9.4. Haga click derecho en el archivo 
“multi_import_SurfaceTemp_start.bat” y seleccione editar para visualizar el contenido del archivo. 
 

 
Figura 9.3. Archivo “batch” para iniciar la importación de múltiples imágenes en forma automática. 

 
Este archive establece en su primera línea se creará un nuevo archivo *.bat, llamado “import_param.bat” 
especificando la ubicación de su directorio ILWIS. La segunda línea agrega otro archivo *.bat, 
“import_param.bat”, especificando la ubicación del directorio donde usted ha descomprimido el ejercicio. 
La línea 3 especifica que el contenido del archivo “SurfaceTemp.rar” debe ser extraido y escrito en el 
mismo directorio. La última línea establece que para todas las imágenes (ahora descomprimidas) 
llamadas “mod11a2*.tif”, otra rutina de procesamiento (archivo “multi_import_SurfaceTemp.bat”) será 
ejecutada. 
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Figura 9.4. Archivo “batch” para importar las imágenes de temperatura de superficie. 

 
 
Esta rutina de procesamiento, la cual es ejecutada luego de que todas las imágenes son descomprimidas, 
comienza con un comando „set‟. Las imágenes son procesadas siguiendo esta rutina de a una por vez en 
función de su nombre de archivo (%1). Dos porciones del nombre del archivo es usado para el 
procesamiento. EL nombre sin extensión („shortfilename1‟) y la fecha de generación del producto 
(„shortfilename2‟). El próximo comando llama el archivo “import_param.bat” que ha sido creado en el paso 
anterior, definiendo la ubicación de “IlwisDir” y “ChapterDir”. La próxima línea ejecuta el programa 
„gdal_translate.exe‟ para importar a formato ILWIS la imagen *.tif que está siendo procesada, y la guarda 
en el mismo directorio. La próxima línea escala la imagen importada alpicando un factor de escala de 0.02 
y una ordenada al origen de 273.15, convirtiendo las unidades de temperatura de Kelvin a Celsius. Note 
que la imagen final convertida, también es guardada en el directorio “Working_Dir” (en este caso 
C:\Chapter9\Working_Dir).  
Ahora diríjase al menú Inicio de Windows, selecciones Ejecutar y escriba „command.exe‟ para correr los 
archivos *.bat. En la nueva ventana de comandos abierta, navege hasta su directorio de trabajo (en este 
caso „C:\chapter9\DataInput\1_SurfaceTemp‟) y ejecute el archivo *.bat de importación de las imágenes 
de temperatura de superficie. Para conocer los comandos necesarios para navegar hasta la ruta de su 
directorio de trabajo, y otros comandos DOS vea la Figura 9.5. 
 

 
Figura 9.5. Iniciando la importación desde una ventana de comandos DOS. 

 
 
Note que en la línea de comandos, el archivo “multi_import_SurfaceTemp_start.bat” será ejecutado 
usando dos parámetros. El primer parámetro especificado es “C:\Ilwis”. Este parámetro indica la ubicación 
del directorio ILWIS en el sistema; en su caso este directorio puede ser diferente. En ese caso, usted 
debe especificar el directorio correcto. El segundo parámetro es “c:\chapter9”; éste indica la ubicación del 
directorio donde se encuentra el ejercicio. Si ha instalado el ejercicio en otro directorio, usted necesita 
corregir este parámetro. Una vez verificado que los parámetros son correctos, presionar “enter” para 
ejecutar la rutina de procesamiento. 
Una vez que la importación haya finalizado, seleccionar desde la ventana principal de ILWIS la opción 
“Window => Refresh”, entonces podrá notar que han sido creados cuatro mapas de temperatura. Luego 
haga doble click en uno de los mapas, por ejemplo “SurfaceTemp_2009145”, use “Pseudo” como 
representación y presione OK para visualizar el mapa. Muévase sobre el mapa con el mouse, 
manteniendo presionado el botón izquierdo, para ver los valores de temperatura. 
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9.5.1.2. Importar y escalar el producto Reflectancia de Superficie de MODIS 
Para importar todas las imágenes necesarias de Reflectancia de Superficie de MODIS (mod09a1*.tif), 
repita el procedimiento descripto arriba y ahora use los datos del sub-directorio 
„C:\chapter9\DataInput\2_SurfaceReflect‟. Tenga en cuenta que ahora en la línea de comandos debe 
escribir “multi_import_SurfaceReflect_start.bat c:\ilwis c:\chapter9”. El archivo 
“multi_import_SurfaceReflect.bat” permite importar las imágenes *.tif a formato ILWIS y escalar los valores 
de reflectancia (ver también Tabla 9.1 y Figura 9.6). 
Una vez que la importación haya finalizado, seleccionar desde la ventana principal de ILWIS la opción 
“Window => Refresh”, entonces podrá notar que han sido creados cuatro mapas de reflectancia 
mod09a12009***_b01 y mod09a12009***_b02 maps (*** = día juliano). Luego haga doble click en uno de 
los mapas, por ejemplo “mod09a12009145_b01”, use “Pseudo” como representación y presione OK para 
visualizar el mapa. Muévase sobre el mapa con el mouse, manteniendo presionado el botón izquierdo, 
para ver los valores de reflectancia. 
 

 
Figura 9.6. Archivo “batch” para importar las imágenes de Reflectancia de Superficie 

 
 
9.5.2. Información Meteorológica 

9.5.2.1. Importación del producto de temperatura del aire 
Se hace uso de registros de temperatura del aire a 1,5 m, provenientes de estaciones meteorológicas 
presentes en el área de estudio. La temperatura del aire de cada estación, con una resolución temporal 
diaria, fue promediada cada 8 días. Esta información puntual así resumida fue interpolada para cubrir la 
totalidad del área de estudio, con el objetivo de obtener información de temperatura del aire con la misma 
resolución espacial que el resto de las variables derivadas de sensores remotos (500 m). 
Para importar todas las imágenes de Temperatura de Aire necesarias (airtemp*.tif), repita el 
procedimiento descripto arriba para importar los productos MODIS y ahora use los datos del sub-directorio 
„C:\chapter9\DataInput\3_AirTemp. Tenga en cuenta que ahora en la línea de comandos debe escribir 
“multi_import_ AirTemp_start.bat c:\ilwis c:\chapter9”. En este caso, la rutina “multi_import_AirTemp.bat” 
solo convierte a formato ILWIS las imágenes tif (ver Figura 9.7).  
Una vez que la importación haya finalizado, seleccionar desde la ventana principal de ILWIS la opción 
“Window => Refresh”, entonces podrá notar que han sido creados cuatro mapas de temperatura del aire. 
Luego haga doble click en uno de los mapas, por ejemplo “airtemp_2009145”, use “Pseudo” como 
representación y presione OK para visualizar el mapa. Muévase sobre el mapa con el mouse, 
manteniendo presionado el botón izquierdo, para ver los valores de temperatura del aire. 
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Figura 9.7. Archivo “batch” para importar las imágenes de Temperatura del Aire 

 
 
9.5.2.2. Importación del producto de Radiación Neta 
Para importar todas las imágenes necesarias de Radiación Neta (netrad*.tif), repita el procedimiento 
descripto arriba para importar los productos MODIS y ahora use los datos del sub-directorio 
„C:\chapter9\DataInput\4_NetRad‟. El último comando en el archivo „multi_import_NetRad.bat‟ reemplaza 
los valores -999.9 por un dígito que representa la ausencia de datos, en el caso de ILWIS ese dígito es 
„”?”. El reemplazo es hecho utilizando una función IFF (ver Figura 9.8). 
 

 
Figura 9.8. Archivo “batch” para importar las imágenes de Radiación Neta 

 
 

Una vez que la importación haya finalizado, seleccionar desde la ventana principal de ILWIS la opción 
“Window => Refresh”, entonces podrá notar que han sido creados cuatro mapas de temperatura del aire. 
Luego haga doble click en uno de los mapas, por ejemplo “netrad_2009145”, use “Pseudo” como 
representación y presione OK para visualizar el mapa. Muévase sobre el mapa con el mouse, 
manteniendo presionado el botón izquierdo, para ver los valores de radiación neta. 
 
9.5.2.3. Remuestreo del producto LST de MODIS 
Luego de importar todos los mapas de temperatura de superficie a formato ILWIS, es necesario 
resamplear esas imágenes para obtener un tamaño de píxel de 500 m. Para hacer esto es necesario 
tipear las siguientes expresiones en la línea de comandos de la ventana principal de ILWIS: 
Surfacetemp_2009145r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009145,airtemp_2009145.grf,nearest) 
Surfacetemp_2009153r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009153,airtemp_2009145.grf,nearest) 
Surfacetemp_2009161r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
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2009161,airtemp_2009145.grf,nearest) 
Surfacetemp_2009169r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009169,airtemp_2009145.grf,nearest) 
Cuando haya finalizado haga doble click en uno de los mapas creados, por ejemplo 
“surfacetemp_2009145r”, use “Pseudo” como representación y presione OK para visualizar el mapa. 
Muévase sobre el mapa con el mouse, manteniendo presionado el botón izquierdo, para ver los valores 
de temperatura de superficie. 
 
 
9.6. Cálculo de ET 

9.6.1. Cálculo de Normalized Difference Vegetation Index (NDVI) 
Calcular el NDVI usando los valores de reflectancia de los canales rojo (b01) e infrarrojo cercano (b02) 
obtenidos del producto Reflectancia de Superficie de MODIS. Para hacer esto, seleccionar de la menú 
principal de ILWIS las opciones “Operations => Raster Operations => Map Calculation”. Tipear el 
algoritmo correspondiente al cálculo del NDVI (Figura 9.9), especificar un nombre de salida (en este caso 
“ndvi_2009145”), seleccionar como “Value” como dominio (“Domain”), especificar el rango de valores 
(“Value Range”) entre 0 y 1, y definir la precisión de los valores (“Precision”) en 0.001. Ejecutar el 
comando presionando „Show‟. Visualizar el mapa creado (“ndvi_2009145”) usando „NDVI1‟ como 
representación. Repetir el mismo procedimiento para calcular el NDVI del resto de las fechas: 153, 161 y 
169. Para realizar el procesamiento en forma eficiente, se aconseja hacer uso del historial de la línea de 
comandos del ILWIS. Solo necesita cambiar el día juliano en la ecuación, entonces presione „enter‟ para 
ejecutar el comando y calcular el nuevo mapa de NDVI. 
 

 
Figura 9.9. Ventana „Map calculation‟ para calcular el NDVI 

 
 
9.6.2. Crear Listas de mapas en ILWIS („Map Lists‟) 
Para calcular la ET de varias fechas en forma simultánea, es conveniente crear listas de mapas o „Map 
Lists‟. Con el propósito de ejecutar una misma operación varias veces, es necesario creae una lista de 
mapas para cada uno de los productos importados que serán utilizados en el cálculo de ET 
(surfacetemp_resampled, ndvi, airtemp and netrad). Para crear una lista de mapas, seleccionar desde el 
menú principal de ILWIS la opción “File => Create => Map List”. Seleccionar la lista de capas (mapas) en 
el orden apropiado para incluir en la lista de mapas, presionar el botón “>” para mover los mapas a la lista 
de la derecha, especificar un nombre de salida para la lista de mapas (en este caso usar “NDVI”), y 
ejecutar el comando presionando OK (Figura 9.10). Repetir rl mismo procedimiento para crear una lista de 
mapas para cada dato de entrada, es decir para “surftempr”, “airtemp” y “netrad”. 
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Figura 9.10. Ventana Crear lista de mapas 

 
 

9.6.3. Calculo del NDVI escalado (SNDVI) 
Para calcular el SNVI a partir de la lista de mapas, seleccionar desde el menú principal de ILWIS la opción 
“Operations =>Raster Operations => Map List Calculation”. Tipear el algoritmo del mismo modo que en la 
Figura 9.11: (@1-MAPMIN(@1))/(MAPMAX(@1)-MAPMIN(@1)). Especificar un nombre a la lista de 
mapas de salida (en este caso „SNDVI‟) y ejecutar el comando presionando „Show‟. Una vez que el 
cálculo de la lista de mapas de NDVI escalado finalizó, hacer doble click en uno de los mapas, por 
ejemplo “sndvi_1”, usar “Pseudo” como representación y presionar OK para visualizar el mapa. Muévase 
sobre el mapa con el mouse, manteniendo presionado el botón izquierdo, para ver los valores de SNDVI 
de superficie. 
 

 
Figura 9.11. Cálculo de la lista de mapas de SNDVI 

 
 
9.6.4. Calcular B y n 
Para calcular B y n a partir de la lista de mapas de „sndvi‟, seleccionar del menú principal de ILWIS la 
opción “Operations => Raster Operations => Map List Calculation”. Tipear el algoritmo como se indica en 
la Figura 9.12 (izquierda): 0.0109+(0.051*@1). Especificar un nombre a la lista de mapas de salida (en 
este caso „B‟) y ejecutar el comando presionando „Show‟. Siga el mismo procedimiento para calcular „n‟, 
pero ahora aplique la fórmula como se indica en la Figura 9.12 (derecha): 1.067-(0.372*@1). Visualizar 
los resultados obtenidos utilizando „Pseudo‟ como Representación. 
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Figura 9.12. Cálculo de la lista de mapas de B (izquierda) y n (derecha) 

 
 
9.6.5. Calcular diferencias de temperature 
Seguir el mismo procedimiento descripto arriba para calcular las diferencias de temperatura entre las 
listas de mapas de temperatura de superficie (“surftempr”) y temperatura del aire (“airtemp”). Seleccionar 
del menú principal de ILWIS la opción “Operations => Raster Operations => Map List Calculation”. Tipear 
el algoritmo como se indica en la Figura 9.13. En este caso use dos listas de mapas de entrada („Input 
MapList‟), “surftempr” como lista 1 y “airtemp” como lista 2. Especificar un nombre a la lista de mapas de 
salida (en este caso „tempdif‟) y ejecutar el comando presionando „Show‟. Visualizar los resultados 
obtenidos utilizando „Pseudo‟ como Representación. 
 

 
Figura 9.13. Cálculo de la lista de mapas de „tempdif‟ 

 
 
9.6.6. Calcular ET 
Usando el calculador de listas de mapas („Map List Calculator‟) aplicar la siguiente fórmula para calcular la 
evapotranspiración en mm d-1 (Figura 9.14): (@1*0.408)-(@2*(POW(@3,@4))). Note que los valores de 
radiación neta son afectados por el factor 0.408 (inversa del calor latente de vaporización) para convertir 
las unidades de MJ.m-2.d-1 a mm.d-1. 
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Figura 9.14. Cálculo de la lista de mapas de „ET‟ 

 
 
Visualizar los resultados obtenidos utilizando „Pseudo‟ como Representación. Para el día juliano 153, el 
mapa de ET debería parecerse al de la Figura 9.15. Desde la ventana activa seleccionar la opción “Layers 
=> Add Layer”, navegar hasta la ubicación “Extensions\Geonetcast-Toolbox\util\maps” y seleccionar el 
vector “country_02”, destildar la opción “Info”, activar la opción “Boundary Only” y presionar “OK”. 
 
 
9.7. Verificar los resultados de ET 

La validación de los valores de ET es una tarea complicada. Al menos para evaluar si los resultados 
obtenidos tienen sentido, fueron calculados los valores de evapotranspiración potencial (ETP) de cada 
estación meteorológica siguiendo la metodología Penman. Con este propósito se utilizaron datos de 
temperatura del aire, velocidad del aire a 1,5 m, humedad relativa y heliofanía efectiva. Los valores 
máximos diarios de ETP para cada período de 8 días fueron calculados. Estos valores pueden ser 
comparados con las estimaciones de ET realizadas en este ejercicio. 
 

 
Figura 9.15. Mapa de ET para el día juliano 153 

 
 
Abrir la tabla “etp_153” y revisar su contenido. Usted notará que existen diferencias notables entre los 
valores de ET calculados por ambas aproximaciones (ETP y ET derivada de sensores remotos). En este 
caso, sólo se usarán aquellas estaciones en que ambos valores son similares. Tipear la siguiente 
ecuación en la línea de comandos:  
finalPet=iff(mean_ETP_Penmanmean_ETP_Thornthwaite<0.5,mean_ETP_Penman,?). 
Presionar „Enter‟ para ejecutar la operación, aceptar las opciones por defecto y presionar „OK‟. Una nueva 
columna será creada y los valores de esta columna podrán ser comparados con los valores de ET 
estimados mediante sensores remotos para el día juliano 153, o ET_2 de la lista de mapas. Cerrar la 
tabla. Convertir la tabla a un mapa de puntos. Para hacer esto, haga click derecho sobre la tabla 
“etp_153” y seleccione la opción “Table Operations => Table to Point Map”. Como sistema de 
coordenadas seleccione “airtemp_2009145” y como mapa de salida ingrese el nombre “etp_153”. 
Presione “Show” para ejecutar la operación. Visualice el mapa creado y cierre la ventana. Desde la 
ventana de mapa activa utilizada para visualizar el mapa “ET_2” seleccione la opción “Layers=> Add 
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Layer”, navegue en el directorio ILWIS, seleccione el mapa de puntos recién creado “etp_153”, active en 
el menú “Display Options” la opción “Atribute”, seleccione la columna “final PET” y presione OK. Desde la 
ventana de mapa activa, seleccione “File => Open Pixel Information”, muévase con el mouse sobre los 
puntos en el mapa y observe los resultados en la tabla de información de píxel (“Pixel information table”). 
Cierre la capa de mapa activa. Convierta el mapa de puntos “etp_153” a formato raster. Haga click 
derecho con el mouse sobre el mapa de puntos “etp_153”, y seleccione “Rasterize => Point to Raster”. 
Selecciones “airtemp_2009145” como sistema de referencia (“Georeference”) y como nombre de salida 
del mapa raster ingrese “etp_153”. Presione “Show” para ejecutar la operación. Usted puede acercar la 
vista del mapa usando la herramienta de “zoom” para ver los resultados. 
Desde el menú principal de ILWIS seleccionar “Operations => Raster Operations => Cross”. Como primer 
mapa elegir “ET_2”, como Segundo mapa seleccionar la columna de atributos “finalPet”. Para hacer esto 
haga click en el sigo “+” delante del mapa “etp_153” para seleccionar la columna apropiada. Como tabla 
de salida especificar. Como tabla de salida (“Output Table”) ingresar “compareETp_Eta” y presionar 
„Show‟. Desde el menú de la nueva tabla creada seleccionar el ícono “Graph”, como eje X elegir “map2” 
(valor de ETP (Penman) resultante de la tabla de atributos) y como eje Y seleccionar “ET_2”, y presionar 
OK. Haga doble click en el ícono X-Axis para especificar el rango de valores del eje (0 a 2, intervalo: 0,5) 
y presione OK. Repita la operación para el eje Y. Destilde la opción “Legend”. Haga doble click sobre el 
ícono “map2 * ET_2” y cambie el color tranparente por rojo. El gráfico resultante debería parecerse al de 
la Figura 9.16. 
 

 
Figura 9.16. Comparación de los valores de ET estimados con sensores remotos y la ETP calculada para 

el día juliano 153 
 
 

9.8. Conclusiones 

En la Figura 9.16 puede verse que los valores de ET estimados mediante el uso de sensores remotos son 
menores a la ETP calculada con datos meteorológicos, lo cual coincide con lo esperado.  
Con el propósito de validar las estimaciones de ET, INTA usará datos de ET medidos mediante el uso de 
torres “eddy covariance” y cálculos de ET a partir de información meteorológica. Actualmente el INTA 
tiene acceso a datos de ET medidos con tres torres eddy covariance, ubicadas en sitios cubiertos por 
coberturas vegetales representativas (bosques nativos, forestaciones y agricultura). Además, en el futuro 
se utilizarán datos meteorológicos provenientes de 150 estaciones instaladas por el INTA a lo largo de 
todo el territorio argentino. 
Para considerar posibles errores en los valores de las variables de entrada utilizadas (NR, B, n and Ts-Ta) 
para el cálculo de ET, se testeará la sensibilidad de las estimaciones de ET explorando los posibles 
efectos de valores extremos de dichas variables. 
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